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Android Programming: Installation,
Setup, and Getting Started

Originals of Slides and Source Code for Examples:
http://www.coreservlets.com/android-tutorial/
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Java, JSF 2, PrimeFaces, Servlets, JSP, Ajax, jQuery, Spring, Hibernate, RESTful Web Services, Hadoop, Android.

Developed and taught by well-known author and developer. At public venues or onsite at your location.

© 2012 Marty Hall

movre
SERVLETS and
JAVASERVER PAGES

SzmEmonl
core

SERVLETS and
JAVASERVER PAGES

MARTY HALL @54

osun

JIARTY HALL - LARRY BROWN

For live Android training, please see courses
at http://courses.coreservlets.com/.

Taught by the author of Core Serviets and JSP, More

W Servlets and JSP, and this Android tutorial. Available at

public venues, or customized versions can be held
on-site at your organization.

=l - Courses developed and taught by Marty Hall
— JSF 2, PrimeFaces, servlets/JSP, Ajax, jQuery, Android development, Java 6 or 7 programming, custom mix of topics
— Ajax courses can concentrate on 1 library (jQuery, Prototype/Scriptaculous, Ext-JS, Dojo, etc.) or survey several

» Courses developed and taught by coreservlets.com experts (edited by Marty)
— Spring, Hibernate/JPA, EJB3, GWT, Hadoop, SOAP-based and RESTful Web Services

Contact hall@coreserviets.com for details




Topics in This Section

* Installing the Software and Documentation
— Java 6
— Eclipse
— Android SDK base
— Eclipse ADT Plugin
— Updated SDK components
— AVD (Android Virtual Device)
* Running Apps
— Import and test an existing app
* Run on emulator

— Create and test a new app
* Run on emulator

— Seeing standard output in the DDMS
— Deploy app to USB-connected Android device
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Installing the Software
and Documentation
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JDK for Java SE 6

« Overview

— Use Java 6 (aka JDK 1.6)
« Java 5 supported only by older Android versions
« Java 7 can technically be used, but new Java 7 features
not supported
— For PC, Linux, Solaris, follow directions at
http://www.oracle.com/technetwork/java/javase/downloads/
* Get JDK, not just JRE
* Get SE (Standard Edition), not EE or Micro Edition
* Don'’t get version with the NetBeans IDE

— For MacOS, Java is preinstalled & updated automatically

Installing Java SE 6

* |Install Java 6 JDK

— http://www.oracle.com/technetwork/java/javase/downloads/

Use this version. The “JDK — Java
Development Kit” includes compiler for
Jjava files, whereas the “JRE - Java
Runtime Environment” is only for
executing prebuilt .class files.

This tutorial uses Eclipse,
s0 do not use this link.

/ As of summer 2012, there

is no NetBeans plugin for
Android development. So,
Eclipse is strongly
recommended even if you
normally use NetBeans for
Java development.
However, IntelliJ IDEA has
Android support: see
http:/www jetbrains.com/
idea/features/
google_android.html

Aftér downloading, run installefv’a"n& ac?:épt all defaults.




Eclipse

« Overview

— Eclipse 1s a free open source IDE (Integrated
Development Environment). Support for Java, HTML,
CSS, JavaScript, C++, PHP, and more.

— Google has free Eclipse plugin to integrate with the
Android SDK.

 Features

— General

» Checks your syntax as you type

* Automatically compiles every time you save file

» Refactoring, debugging, templates for common tasks, etc.
— Android-specific

* Deploy apps to Android emulator

» Configure virtual environments
» Drag-and-drop GUI builder

Installing Eclipse
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* Go to eclipse.org, click on “Downloads”
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— Results in
http://eclipse.org/downloads/
— Can use either “for Java” or
“for Java EE”. e
« | use EE version since | also use Eclipse for Web apps.
— Latest version (3.7 — Indigo) recommended.
* Previous version (3.6 — Helios) still supported
* Older versions (3.5 and earlier) not supported




Running Eclipse

Unzip the downloaded file (no installer!)
— Call the folder you unzip into “installDir”

Double click eclipse.exe
— From installDir/bin

Click on
“Workbench” icon

— Next time you bring
up Eclipse, i1t will
come up in workbench automatically

Shortcut
— Many developers put Eclipse link on their desktop s

Helios

* R-click eclipse.exe, Copy, then go to desktop, R-click, and
Paste Shortcut (not just Paste!)

<[ » Computer » OS(C) b eclipse » + [ 4 |[ searcn o

atifactsxm|  eclipse.ere  eclipseini  eclipsecexe  epl-vi0html s er pidd.. noticehtml

The Android SDK

« Overview
— Android-specific libraries
— Dalvik (Android virtual machine) compiler
— Android emulator (to run without physical device)
— DDMS debugging environment

 Documentation
— Installation Bookmrk these URLs!
* http://developer.android.com/sdk/installing/index.html
— Developer’s Guide
* http://developer.android.com/guide/components/index.html
— JavaDoc (API Reference)
* http://developer.android.com/reference/classes.html

— Tutorials and articles
* http://developer.android.com/resources/index.html




Installing the Android SDK

e Download and run installer

— From http://developer.android.com/sdk/
* linstall in C:\android-sdk

— Sets up basic SDK, but omits many components
 Detailed instructions
— http://developer.android.com/sdk/installing/index.html

- Postponed step

— After installing Eclipse plugin, we will run the Android
SDK Manager to get important missing components

» Easiest to do from Eclipse. See upcoming slide after
Eclipse ADT installation.

Eclipse ADT Plugin

« Overview

— ADT (Android Development Tools) provides many
useful features accessible directly in Eclipse

* Integration between Eclipse & Android command-line tools
» Drag-and-drop GUI builder
* Many development and debugging aids

 Detailed installation instructions

— http://developer.android.com/sdk/installing/
installing-adt.html

* More details
— http://developer.android.com/sdk/eclipse-adt.html




Installing Eclipse ADT

Steps
— Start Eclipse
— Help = Install New Software ...
— Click “Add” in upper-right
— In Add Repository, for Name en
Location enter https://dl-ssl. google.co
— Click OK, select checkbox
next to Developer Tools, Next,
see packages to be installed,
accept license, Finish.
Restart Eclipse if asked.
— Run Android SDK Manager

» Should be prompted; if not, i
Windows = Android SDK Manager
See next slide for details =
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Updating SDK
Components

Run Android SDK manager

— Window = Android SDK Manager

* Probably prompted automatically after installing ADT
plugin and restarting Eclipse

— Select all entries, except that you can omit Android

versions older than 2.2 o —
* Click “Install n packages”
* Runs for a long time
Detailed instructions

— http://developer.android.com/
sdk/installing/adding-packages.html -
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Android Virtual Devices (AVDs)

 Overview

— An AVD (Android Virtual Device) is an Android Emulator

configuration that lets you model an actual device by defining
hardware and software options —

. Idea o ‘fﬁ: -
— Define several AVDs at different

Android API levels to test against. et
At least two:

* Newest version (e.g., 4.1 — Jelly Bean)

« Most common version (2.3.3 as of 2012) et

— To see statistics for versions of currently used Android devices, see
http://developer.android.com/about/dashboards/index.htmi

* Detailed instructions

— http://developer.android.com/guide/developing/devices/
managing-avds.html

Defining an AVD

 Defining
— Window = AVD Manager

— Click on “New” at top. Choose name (arbitrary) and
options. You can (should!) create multiple AVDs.

. Options e

— Target (i.e., target API version) =

* 4.1 to test tablet and new features

* 2.3.3 to test most common phones | s =0 w

— SD Card size ”

* Can be omitted. Or, choose middle
of the road value, e.g., 4 GB

— Skin
» Use default for the target you chose

EEEEEEE
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Configuring Eclipse ADT

- Set SDK Location
— Window = Preferences = Android
— Click Browse and point at place you installed the SDK

] (]

+ Optional: disable sending stats to Google
— Window = Preferences = Android = Usage Stats
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Running Apps on
Emulator
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Big Ideas

* Running apps
— Soon, you want to learn how to write your own apps. First,
however, we will practice running existing apps.

« Ways to run

— Covered here
* On the Android Emulator. Deploy directly from Eclipse.
— During development, do your normal testing here
* On an Android device. Deploy from your PC via USB.
— Other options covered online
* On an Android device. Deploy from a Web site.
* On an Android device. Deploy via email.
* On and Android device. Deploy from the Android Market

* Writing apps

— Covered in later tutorial sections. That is the fun part!

Running the HelloAndroid App
in Emulator

e HelloAndroid

— Super-simple app to test deployment and execution steps.

* For students in live classes, this project is already in your
Eclipse workspace.

* For online readers, download project from the Getting Started
section of Android tutorial and import into Eclipse.

— http://www.coreservlets.com/android-tutorial/

» Steps to run it
— Import it if necessary
* File > General > Existing Projects...
— R-click on project on L side of Eclipse
— Run As = Android Application
* Long wait while emulator initializes

* Do not close emulator when done
— Next time, app will come up much faster




HelloAndroid: Result

@ 5550:Android-2.2 [f=] = |fssa]

Hello Android Test Proje
Hello, Android

Code will be discussed in next tutorial section.
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Making Your Own
Android App
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Making Your Own Android App:
Basics

* ldea

— When you create a new app, it has simple “Hello World”
functionality built in.

* S0, you can create and test an app without knowing
syntax (which is not discussed until next tutorial section)

- Steps
— File © New > Project > Android = | ===
Android Application Project e

* Next time you can do File > New >
Android Application Project

— Fill in options as shown on next pages

» & BB

— Run new project as shown previously | ° = )

* R-click 2 Run As - Android Application

New Android App:
Setting Project Options (Pg. 1)

* New Android Project Settings: Page 1

— Application Name
* Shown in Play Store and Settings > Manage Application List. Usually same as
Project Name.
Project Name
» Eclipse project name. Follow naming convention you use for Eclipse. Not used
elsewhere.
Package name

* Apps on a particular Android device must have unique packages, so use
com.yourCompany.project

Build SDK

» The Android version used to build/compile your project. This can be any version (e.g.,

the most recent), but the safest option is to make it match the minimum SDK below.
Minimum Required SDK

» The Android version that you want to run on. For most phone apps, choose 2.3.3,
since that is the most common version in use worldwide. For learning new features,
use latest version (4.1 as of summer 2012).

* The safest option is to use a number to match Build SDK. Summarized in Eclipse
dialog, but for details, see http://developer.android.com/guide/topics/manifest/
uses-sdk-element.html#ApiLevels




New Android App:

Setting Project Options (Pg. 1)

Ecli ject
clipse projectname —__ |

Package. Use naming convention
to ensure uniqueness

Android version used to compile your project — "

Android version that you want to run on
Usually number corresponding to Build SDK

@) New Android App

New Android Application
Creates 2 new Android Application

ication Mame:® AndroidTest
Project Name:@ AndroidTest

Package Name:g com.corese

rvlets.androidtest

/‘“‘“IA ndveid 233 49110
\\\\\\ Required SDICGIAPLLG: Andicid 233 (Gingerbread]

[rfark this project as a library
[/] Create Project in Workspace

Ci\eclipse-workspace\androidiAndroidTest
. Choosethe lowest version of Android that your
devices, but means fewer features are avai
the market.

&)

by

Iable. By targeting APIS and later, you reac

application will suppert. Lower APl levels target more
h approxi

mately 93% of

New Android App:
Configure Launcher Icon

Purpose

— To choose the picture displayed on the Android device,
that, when clicked, launches the app.

Defaults

— Use defaults for development
and testing. Just press “Next”.

&) New Android App

Configure Launcher Icon
Configure the attributes of the icon set

—

Choose...| “=

[¥] Trim Surroun
Additional Padding:
- =

e s

Background Color:

ding Blank Space




New Android App:
Create Activity

- Choose “BlankActivity”

— The Master/Detail option is used rarely,
and applies only to Android 3.0 or later.

8] New Android App = 2=
Create Activity

Select whether to create an activity, and if so, what kind of activity.

[¥] Create Activity

BlankActivi

MasterDetailFlow

New Blank Activity

Creates a new blank activity, with optional inner navigation,

New Android App:
New Blank Activity

» Options for Blank Activity
— Activity Name

* Name of “main” Java class. This is the class you will edit first.
Class name often corresponds to project name.

— Layout Name

» Base name of XML file in res/layout folder. Used to give layout to
app. Often just called “main”. Will be referred to in main Java
class with R.layout.layout_name. [ -y

_ Navigation Type i | (=]
« For now, leave this as “None” o T —
— Hierarchical Parent
» Parent Activity (for when user
presses Up). Empty for now.
— Title

» Text that will be shown on Android
title bar. “




Running New App on Emulator

 Builtin functionality

— Newly created projects automatically have simple “Hello
World” behavior

- Execution steps e

Android Test

— Same as with any project

* R-click > Run As -
Android Applicaton

— Reminder: do not close
emulator after testing.
Emulator takes a long time
to start initially, but it is
relatively fast to deploy
a new or a changed
project to the emulator.

Hello world!
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Seeing Standard Output
in DDMS
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DDMS Basics

* Idea

— DDMS (Dalvik Debug Monitor Service) is a tool that supports many things
» Simulate incoming calls in emulator
» Set GPS locations in emulator
* See print statements and runtime errors

- Simple usage now

— Start DDMS

* Window - Open Perspective
- Other > DDMS

* Once you do this once, you
can click on “DDMS” at o i

top right of Eclipse
e Click on “Java” to returm DD&S 5

— See print statements =
» Look in LogCat window at bottom
* Type part of output into Filter field to see specific output

s nevi
System.out.println("Print statements and runtime errors are shown in| LogCat window in DDMS");

DDMS Output (HelloAndroid)

File Edit Source Refactor Navigate Search Project Run Window Help

° COde O-®dh & Bid %‘).W@W?D%ih;ds‘ E
— Put System.out.println £
1in main onCreate method =

* See code in screenshot
on previous page

» onCreate and other syntax E;.,,«[W S
discussed in next section W

Incoming number

Location Controls
Manual [GPX_ [ KML
al

Seagesimal

Longitude 122084095

Output of System.out.printin

Latitude 37422006

[send

e
051814400 | 303 System3™ Printstaternents and runtime erors are shown in LogCat window in DDMS

Entered so it is easier to find specific output among

the many informational messages that emulator prints\
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Running Apps on
Physical Android Device
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Running Apps on Android
Device

* Ildea

— The vast majority of your testing will be on Android emulator. But
sometimes you want to test on a physical phone or other Android device to
test compatibility and to use camera, GPS, contact list, etc.

* You first make a signed application package (YourApp.apk), then you have
various options for sending it to the phone
« Options
— Covered here
» Connect phone via USB, use Eclipse to deploy
— Can learn on your own
» Export signed app from Eclipse, use adb to install on phone
— See http://developer.android.com/tools/help/adb.html#move
» Other approaches
http://developer.android.com/tools/publishing/publishing_overview.html
— Submit app to Android marketplace
— Email apk file to email address of phone

— Deploy apk file to a Web site, then connect there from phone. Must set MIME type to
application/vnd.android.package-archive.




Deploying via USB Connection

* Prereq: install drivers for Android device

— Plug phone (or other Android device) into computer.

* Recent OS’s might find drivers automatically. If not, download
from device manufacturer. See list at
http://developer.android.com/tools/extras/oem-usb.html

— After installation, plug in phone, then go to android-dir/platform-tools/
and run “adb devices”. Your device should now be listed.

» Steps

— Android device
* Enable USB debugging
* Allow unknown sources
» Verify USB drivers are on computer

— http://developer.android.com/tools/extras/oem-usb.html

* Plug into computer via USB

— Eclipse
* R-click app, Run As - Android Application

— If emulator is open, will be given a choice of which device to deploy to.
If emulator not open, will deploy to physical device automatically.

Configuring Android Device

S ¢ 0O

- Enable USB debugging grex

_ Settings 9 Applicatlons 9 Il)-igE rfwltiiE\ijhg@%IL?Sgws connected
DGVCIOPment . Stay awake
° Req UII’ed U SB debugglng Screen will never sleep while charging

— Allows PC to send commands  [alelllE IS
Via USB Allow mock locations

* Optional: Stay awake

— Phone/device won'’t sleep when
. Unknown sources
ConneCted via USB Allow installation of non-Market

* Optional: Allow mock locations l\‘:“ —
. solicat
N Let PC Send fake GPS |OCat|ons Ma?ar;:ieare !Jng)r:j?oxfle-c\)rztsa\\ed

* Allow unknown sources

— Settings = Applications
Devel t
Unknown Sources Seﬁ)ﬁo?ﬁﬂi?\caﬂorﬁ development

Application settings

Running services

View and control currently running services

Double tap home launch @y




Running App on Device

[
e

} = B 8:15em

« After running via Eclipse o

— Will show automatically Dler oictionary  5lNA
* To run later
— Go to installed apps Eas;Tether Email  EMERGENC

— Tap new app ,.m
w
* Remember that the human n

R . Flashlight ~ FM Radio Gallery
readable name (Application Name
from new Android Project wizard)
is shown, not the Java class name

. . D 8:16
— If you want to install update Hei.o Android Test Project
« Uninstall old version first | I
Hello

— Settings > Applications > YourApp EGEEERS

- Uninstall R
— Or long-press your app and choose

“Uninstall”

© 2012 Marty Hall

Wrap-Up

Customized Java EE Training: http://courses.coreservlets.com/
Java, JSF 2, PrimeFaces, Servlets, JSP, Ajax, jQuery, Spring, Hibernate, RESTful Web Services, Hadoop, Android.

Developed and taught by well-known author and developer. At public venues or onsite at your location.




Summary

Install software

— Java 6, Eclipse, Android SDK, Eclipse ADT plugin
Bookmark documentation

— Developer’s Guide and more at developer.android.com

Update/configure software
— Set SDK location in Eclipse
— Get updated components via Android SDK Manager
— Define at least one AVD to run apps on emulator

Run apps

— R-click project, Run As = Android Application
*  On emulator (usually)
» On physical Android device (once in a while)

Make new app

— File > New - Project 2 Android = Android Application Project
See output of print statements

— In LogCat window of DDMS
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Questions?

JSF 2, PrimeFaces, Java 7, Ajax, jQuery, Hadoop, RESTful Web Services, Android, Spring, Hibernate, Servlets, JSP, GWT, and other Java EE training.

Customized Java EE Training: http://courses.coreservlets.com/
Java, JSF 2, PrimeFaces, Servlets, JSP, Ajax, jQuery, Spring, Hibernate, RESTful Web Services, Hadoop, Android.

Developed and taught by well-known author and developer. At public venues or onsite at your location.




